HELIX DN9340/DN9344
Remote Control Software V3.07
User Guide
Contact Details
Klark Teknik
Klark Teknik Building
Walter Nash Road
Kidderminster
Worcestershire
DY11 7HJ
England

Tel: +44 1562 741515
Fax: +44 1562 745371

Websites: www.midasconsoles.com
          www.klarkteknik.com

Due to a policy of continual product improvement, specification and features may be subject to change without notice.
CONTENTS

1. INTRODUCING THE HELIX REMOTE CONTROL SOFTWARE ........................................ 5

2. INSTALLING HELIX RCS ................................................................................................. 6
   2.1. Minimum System Requirements ....................................................................................... 6
   2.2. Software Installation .......................................................................................................... 7

3. GETTING STARTED ........................................................................................................... 8
   3.1. Opening HELIX RCS within the ELGAR Library Manager ............................................... 8
   3.2. The DN9340 Device Workspace ...................................................................................... 9
   3.3. Quick Tour of the DN9340 Device Views ....................................................................... 9

4. CONFIGURING THE HELIX ADD-IN .............................................................................11
   4.1. Network Identification .....................................................................................................11
   4.2. Linking and Bypassing Channels ....................................................................................12

5. PROGRAMMING EQ .......................................................................................................13
   5.1. Graphic Equalisation .......................................................................................................13
   5.2. Parametric Equalisation .................................................................................................15
   5.3. Dynamic Equalisation ....................................................................................................17
   5.4. Filters ............................................................................................................................19

6. WORKING WITH MULTIPLE HELIX ADD-INS ...............................................................21
   6.1. Building your Network Remotely ....................................................................................21
   6.2. The Fast Navigation Screen ...........................................................................................21

7. USING HELIX RCS TO CONTROL AN EQUALISER NETWORK ....................................23
   7.1. Overview ........................................................................................................................23
   7.2. Serial Connection ...........................................................................................................23
      7.2.1 Equipment Requirements ..........................................................................................23
      7.2.2 Connection Procedure .............................................................................................24
   7.3. Ethernet Connection .....................................................................................................25
      7.3.1 Equipment Requirements ..........................................................................................25
      7.3.2 Configuring the Network Devices .............................................................................27
      7.3.3 Connection Procedure .............................................................................................34
      7.3.4 Fault Finding Tips .....................................................................................................35
   7.4. Working Online .............................................................................................................36
      7.4.1 Communications Overview .......................................................................................36
      7.4.2 Online Operation .......................................................................................................37
      7.4.3 Activity Indicators .....................................................................................................39
      7.4.4 Bypassing Channels .................................................................................................39
   7.5. Solo Tracking Operation ...............................................................................................40
   7.6. Protecting System Settings ..........................................................................................41
8. **STORING/RECALLING MEMORY SETTINGS** ..........................................................43

8.1. Memory Working with Individual Add-Ins........................................................................43

8.2. Global Memory Management.........................................................................................46
1. INTRODUCING THE HELIX REMOTE CONTROL SOFTWARE

The HELIX Remote Control Software (HELIX RCS) enables engineers to remotely program a network of up to 64 HELIX equaliser channels from a laptop or PC for onward downloading to the DN9340 or DN9344 units at a venue. Hence, basic programming can be done in advance of a show from home or en route, leaving more time for fine-tuning.

At the venue, the settings can be quickly downloaded to the equaliser network. Thereafter, a HELIX RCS laptop/PC can be used for real-time control of the slave equaliser network during both set-up and performance. Using a the HELIX RCS in place of a DN9340 offers an enhanced visual overview of slave performance, as well as significant time-savings in switching between slave units, navigating equalisation views and adjusting settings. Furthermore, for optimal control during set-up, the laptop/PC can be set up to communicate with the slave network over a wireless connection, leaving the engineer free to move around the venue while adjusting the equalisation settings. For performance, conventional RS-232 or RS-485 communication may be used. Where required, settings can also be uploaded from the DN9340/DN9344 Equalisers to the HELIX RCS.

In addition to the active settings, HELIX RCS can also be used to remotely program all the equaliser memories, and that includes the 32 lockable Preset (flash) memories which can only be programmed from an external computer.

The HELIX RCS runs as an Add-In to the Midas Klark Teknik ELGAR Library Manager, enabling you to work on settings for your equaliser devices alongside other Midas or Klark Teknik devices, for example, a console, and save them all in a single show file. The show file can then be reused from venue to venue. In addition, you can minimise time and effort by copying settings between the HELIX RCS Add-In devices.
2. Installing HELIX RCS

2.1. Minimum System Requirements

Operating System: Windows 2000 or Windows XP

Computer/Laptop: Display resolution minimum 1024 X 768 pixels
Pentium 3 500MHz (or equivalent)
256MB RAM
Minimum 10MB of free disk space on hard drive

Connectivity: Connection to the DN9340/DN9344 units can be made by serial cabling or Ethernet (including wireless), with either a RS-232 or RS-485 input to the first Helix Unit. Full connection options and respective equipment requirements are detailed in Section 7. For familiarisation purposes, a basic serial connection may be made to a single unit as follows:

**From laptop/PC D9 COM port** - Use the Host cable to connect to the PC PORT on the HELIX Front panel (RS323 input), or use the Klark Teknik LBB 485 Converter, powered from a PS2 mouse port, to connect to the rear panel XLR Comms In (RS-485 input).

**From laptop/PC USB port** - Use a KK systems USB232 converter plus host cable to connect to the PC PORT on the HELIX Front panel (RS323 input), or use the B+B Electronics USOTL4 to connect to the rear panel XLR Comms In (RS-485 input).

For details of converters please refer to http://www.klarkteknik.com/faq_connection.htm

**Note:** For Ethernet connectivity, the HELIX unit must be operating V3.03 (or later) host code.

Software: The following software must be installed prior to installing the HELIX Remote Control Software:


**Midas ELGAR Library Manager V2.00** available at http://www.midasconsoles.com/downloads.htm
2.2. Software Installation

HELIX RCS is provided as an .exe file from the Klark Teknik website (www.klarkteknik.com) with an integral Set Up Wizard that guides you through the installation process on your laptop/PC.

Note: We recommend that you save the .exe file to your desktop (or other holding folder) rather than opening the file while the Internet transfer is in progress. This will avoid the possibility of the integral Set Up Wizard interrupting the transfer, especially on slower Internet connections.

Once you have downloaded the .exe file, install it on your laptop/PC as follows:

1. Run the HelixRCS_V3_06.exe file. The Set Up Wizard should appear on screen within a few seconds.

2. Follow the on-screen instructions, leaving the Destination Directory as the preset default, that is, "C:\Program Files\Klark Teknik Group\ELGAR", unless you have installed ELGAR in an alternative directory. In the latter case, specify your alternative ELGAR Destination Directory. Note that the Wizard Information page details the latest improvements to the software; previous users may find this particularly useful.

3. When the installation has been successfully completed, click Finish to exit the Wizard. The HELIX RCS will now be available through the ELGAR Library Manager.
3. GETTING STARTED

3.1. Opening HELIX RCS within the ELGAR Library Manager

Note: To run HELIX RCS you must have installed the Midas Klark Teknik ELGAR Library Manager on your laptop/PC. The ELGAR Software and User Guide may be obtained from our website at www.midasconsoles.com.

HELIX RCS runs as an ‘Add-In’ to the ELGAR Library Manager which provides a single management window for various Midas and Klark Teknik remote programming software.

By opening multiple Add-Ins within the ELGAR Library Manager, you can work on settings for the various Midas and Klark Teknik devices associated with a show at the same time. For example, you can Add-In a series of Klark Teknik DN9340 Equaliser Add-Ins to cover your equaliser network, plus a Midas Heritage 1000 add-in with settings for a H1000 console. Furthermore, as the concurrently opened Add-Ins are saved, reopened etc. as a single show file using the ELGAR File menu commands, you will save time in file management.

To Add-In an HELIX RCS device to the ELGAR Library Manager:

1. Open ELGAR by double clicking on the ELGAR desktop icon.
2. From the ELGAR Main Menu Bar, select Tools > Add Device > DN9340 EQ.

A DN9340 device screen, as shown below, is opened inside the ELGAR Library Manager. This device screen is the workspace where you remotely program scene settings for either a DN9340 or one half of a DN9344, that is, a single HELIX equaliser. The screen provides a graphic display and a series of ‘tabs’ that emulate the display and menus of the DN9340.

A DN9340 Fast Navigation screen is also opened (behind) at the same time. This becomes useful when you are working with several DN9340 device screens, as it enables you to quickly switch to any channel on any of the device screens. It is also used for monitoring connection status of your networked devices during online ‘radio’ operation.

You can open up to 32 DN9340 device screens (generally referred to as HELIX Add-Ins) within a single show file.
3.2. The DN9340 Device Workspace

The key features of DN9340 device workspace are identified in the figure below.

3.3. Quick Tour of the DN9340 Device Views

The DN9340 Device workspace has six key views that relate to the main ‘menu pages’ of the DN9340 unit. These are:

- Home View
- Filter View
- Dynamic Equalisation View
- Parametric Equalisation View
- Graphic Equalisation View
- Memory View

The views are shown overleaf.

To quickly switch to a different view on the same channel

- Click on either the upper or lower tab of the required view.

Note: The right-to-left order of EQ tabs on the Navigation Strip reflects, and provides a reminder of, the order in which signal processing is applied to your input. The manual follows the typical order of programming equalisation, that is, graphic, parametric, dynamic, filters.
To quickly switch to a different view on the other channel

- Click on the required view button on the Channel A or B navigation strip.

As you switch views the display is updated to show the frequency response curve of the currently selected EQ. Home and Memory views show the combined EQ frequency response.

The settings and frequency response of each mode of equalisation are readily visible and adjusted via the respective Equalisation view.

The graphic display on the Home and Memory Views shows the overall frequency response of the ‘scratchpad’ memory (active settings of slave unit).
4. CONFIGURING THE HELIX ADD-IN

4.1. Network Identification

A single show file will usually have multiple HELIX Add-Ins equating to the networked HELIX units in your physical set up. Each Add-In must be uniquely addressed and configured to match its physical counterpart, that is, the slave DN9340 or DN9344 HELIX that it will remotely program, and also the communication mode must be specified. In addition, to make it easier to navigate between device screens without confusion, device screens and channels should be labelled. All this is done in the Home view of the HELIX Add-In.

To configure the HELIX Add-In to match its physical counterpart

1. Switch to the Home view from the Channel A or B Navigation Strip, or by clicking on the upper or lower Home tab.

Specify the HELIX unit details in the upper Home tab

2. Type in a Unit Name (maximum 16 characters) to help identify the unit. The title bar of the workspace changes to the new name as you type.

3. Specify the numerical Address of the slave HELIX that you wish this HELIX Add-In to control by typing in the number (between 1 and 32) or using the scroll.

Note: HELIX RCS will automatically assume the lowest available Address number when you add-in a new DN9340 EQ device, up to the maximum of 32. In keeping with network protocol, HELIX RCS will not allow two devices to be assigned the same address.

4. Click on the Com Port drop down menu and select the laptop/PC Com Port that will be connected to the slave HELIX PC Com port. If using a wireless network, specify the virtual COM Port number (see Section 7.3.2).

5. Select a Comms Mode from the following options in the drop down menu:

   - **Klark Teknik**: If using a Klark Teknik LBB-485 converter.
   - **Generic Echo On**: If using a standard RS-232 host cable to the HELIX front panel PC Port or a third party RS-232/RS-485 converter.
   - **Generic Echo Off**: if you are using a device without a hardware echo. (Some converters allow you to turn the RS-485 signal echo off.) This is the setting to use for wireless connection.
Specify channel details in the lower Home tab

For each channel, type in a **Long Name** (maximum 11 characters, upper or lower case) and **Short Name** (maximum 3 characters, upper case) that identifies the channel function/location in the equaliser network.

**Note** When editing a Channel in the Home tab, it is highlighted in dark grey to indicate that it is the active view on the graphic display.

The **Long Name** is used on the alphanumeric display when the slave is a DN9340, while the short name is used by the 'starburst' display when the slave is DN9344. The **Long Name** is also used to identify channels in the Fast Navigation Screen. Both names are shown above the graphic displays of the HELIX Add-In and slave DN9340 to indicate which channel is currently on display.

Set the **Delay** for Channel A and Channel B by scrolling the s, ms and ss fields or typing a value. The maximum delay allowed is 1s.

Set the input gain **Level** for Channel A and Channel B by typing in a value or by using the slider to the right of each channel panel for coarse adjustment and the field scroll for fine adjustment. (Clicking above/below the slider pointer increases/decreases the level in 0.5dB steps.) To mute the input signal, click on **Mute**. The button changes to red to show that it is currently active.

**Note** When settings are transferred to/from the unit, the Mute is linked to the **Off** setting, found just below –40dB (the HELIX units do not have Mute buttons). So that, when writing settings to the unit, 'Mute on' will set the unit to **Off**. Conversely, when getting settings from the unit, an **Off** value at the unit will switch Mute on and set the **Level** field to –40dB. The only exception to this is when a signal interruption occurs while working online (see section 7.4).

### 4.2. Linking and Bypassing Channels

- **To link the channels for identical operation**
  1. Click on the Navigation Strip of the channel whose settings you wish to retain.
  2. Tick the **Link AB** check box.

  The settings of the background channel are overwritten and locked to the channel currently on view. Both Navigation Strips and both Channel Panels on the lower Home tab are highlighted as active to indicate that any changes made to settings are applied to both channels. Although the graph is labelled with only Channel A names, Channel B names are retained for downloading.

- **To return to separate channel operation, clear the **Link AB** check box.**

- **To switch a channel out of the equaliser network**
  Tick its **Bypass** check box on the respective Channel Panel on the lower Home tab.
5. PROGRAMMING EQ

5.1. Graphic Equalisation

➢ To switch to the Graphic Equalisation view

- Click on the Graphic button of the Channel A or B Navigation Strip, as required. (If staying on the same Channel, you may prefer to click on a Graphic tab).

The upper Graphic Mode tab is used to set the EQ type, bypass state, autogain etc. for the current channel. The lower Graphic Shaping tab provides 31 fader controls for adjusting the gain of the 31 bands of the 1/3 octave equaliser; these are mirrored by fader controls along the frequency response graph.

➢ To specify the EQ mode for the current channel

1. In the upper tab, open the EQ Type ▼ drop down menu and select Proportional, Constant, or Symmetrical Q. Type in or scroll to the required Q.

or

Select a Klark Teknik DN360 or DN27 emulation curve from EQ Type ▼ drop down menu. The Q field is disabled for the emulations.

Note: Refer to the DN9340/DN9344 Operators Manual for application notes on Equalisation modes and Q.
2. To apply autogain, tick the [AutoGain] check box and type in (or scroll) the required value in the field below.

3. Use the [Unit Display] drop down menu to set the Graphic display mode that DN9340 units should assume when taken out of slave operation; this only comes into effect if the slave is a DN9430. The choice made here has no effect on your Add-In device display.

» To Bypass the graphic EQ on the current channel
- Tick the [Bypass] check box in the upper tab.

» To adjust a fader level

**Hint:** To help fader selection at the graph, the frequency band and dB level is displayed as you hover over a fader.
- Click and drag the fader on the graph or on the lower tab. The graph and tab faders are linked so that they move simultaneously.

The overall frequency response (black line) updates as you adjust the fader. The individual response of the fader is also shown (in red) while the fader is selected.

» To adjust a group of faders together

1. Click and drag the cursor diagonally over the group of faders to enclose them in the selection box. The selected faders are highlighted in red.

2. Click and drag any of the selected faders to move the whole group up or down by the same dB while retaining their relative values.

3. To deselect the group, click anywhere on the graph outside the group.

The overall frequency response (black) updates as you adjust the group. The individual response (red) is only shown for the fader that you drag. If required, the response of the other faders can be checked by clicking on each one in turn.

» To reset all faders to zero
- Click on the [All Flat] button in the Global Graphic tab.

» To switch a fader out of the circuit

1. Tick the check box directly beneath the fader in the lower tab.

   The fader response is faded to grey on the graph (the setting is retained for recall) and its contribution is removed from the overall frequency response.

2. To switch the fader in again, clear the check box.
5.2. Parametric Equalisation

To switch to the Parametric Equalisation view

- Click on the Para button of the Channel A or B Navigation Strip, as required. (If staying on the same Channel, you may prefer to click on a Parametric tab).

The upper Parametric Mode tab is used to set the EQ characteristic (EQ type), bypass state and graph display mode (when a DN9340) for the current channel. The lower Parametric Shaping tab provides a series of PEQ control panels for added PEQ sections. PEQ sections can also be adjusted at the display by using the 'target cursor'.

To set the Parametric EQ mode for the channel

1. Select a Proportional, Constant, or Symmetrical Q characteristic from the EQ Type drop down menu (right).
2. Use the Unit Display drop down menu to set the Parametric display mode that the HELIX unit should assume when taken out of slave operation; this only comes into effect if the slave is a DN9430. The choice made here has no effect on your Add-In device display.

Note
Refer to the DN9340/DN9344 Operators Manual for application notes on Equalisation modes and Q.
To Bypass the parametric EQ on the current channel

- Tick the □ Bypass check box in the upper Parametric tab.

To add a PEQ section to the graph

1. Click on the Add button in the lower Parametric tab. A PEQ panel with Level, frequency and Q is added to the tab (shown right) and a target appears on the graph at 1kHz.

2. Left click on the target and drag it to the required frequency and dB level. Right click on the target and drag the mouse up/down (the target remains still) to increase/decrease the width of the PEQ section, that is, by adjusting the Q value. The values in the PEQ panel track the target.

3. If required, fine tune settings by scrolling the PEQ panel. Frequency, Level and Q fields.

**Hint** Adjusting PEQ positions: The target provides quick but coarse adjustment, the scrolls enable fine adjustment. If you know the exact values you wish to apply, it may be quicker to type the values into the PEQ panel. Frequencies in kHz should be entered with a ‘k’ suffix, that is, 12.5k for 12.5 kHz. Frequencies will be automatically adjusted to the nearest valid increment.

To activate the target at an existing PEQ section

- Click anywhere on its PEQ panel, but note that if you click on the very bottom of the panel, you also click the Out field and thus change the in/out status. The selected panel becomes highlighted and the target 'switches' to the associated PEQ section.

The target cannot be ‘switched’ to another PEQ by clicking on the graphic (this would conflict with its function as a repositioning control for the underlying PEQ section).

**Note** The order of the PEQ panels will not necessarily mirror the order of the PEQ sections on the graph, as targets can be moved along the frequency axis to suit requirements.

To switch a PEQ section out of the circuit

1. Tick on the □ Out check box at the bottom of the respective PEQ panel.

   The PEQ section is faded to grey on the graph and its contribution is removed from the overall frequency response. The target stays on the PEQ section so that the PEQ can still be adjusted while switched out.

2. To switch the PEQ section in again, clear the □ Out check box.

To remove a PEQ section from the graph

1. Move the target to the PEQ section you wish to remove by clicking on its PEQ panel. Click the Remove button in the Parametric Shaping tab.

2. At the prompt, click Yes to confirm the removal the PEQ or No to cancel.

The PEQ section is removed and the remaining PEQ panels re-numbered, if required.
5.3. Dynamic Equalisation

To switch to the Dynamic Equalisation view

- Click on the Dynamic button of the Channel A or B Navigation Strip, as required. (If staying on the same Channel you may prefer to click on a Dynamic tab).

The upper Dynamic Mode tab is used to set the characteristic of the Threshold Dependent Dynamic EQ (T-DEQ), bypass state and graph display mode (when a DN9340) for the current channel. The lower Dynamic Shaping tab provides a control panel for each of the two Dynamic EQ sections that can be applied to the frequency response. The Dynamic EQ sections can also be adjusted at the display by using the target cursor.

To set the Dynamic EQ mode for the channel

1. Select a Proportional, Constant or Symmetrical Q characteristic from the EQ Type drop down menu.
2. Use the Unit Display drop down menu to set the Dynamic EQ display mode that DN9340 units should assume when taken out of slave operation; this only comes into effect if the slave is a DN9430. The choice made here has no effect on your Add-In device display.

Note

Refer to the DN9340/DN9344 Operators Manual for application notes on Equalisation modes and Q.
To Bypass the Dynamic EQ on the current channel

- Tick the Bypass check box in the upper Dynamic tab by clicking on it.

To shape a Dynamic EQ section

1. Click on its control panel in the lower Dynamic tab so that it is highlighted. (Dynamics initially default to 1kHz).
2. Scroll or type in the Lo Threshold (quiet) and the Hi Threshold (loud) for the signal level.
3. Left click on the target and drag it to the required frequency and boost/cut. The currently selected threshold is marked at the bottom left of the target. The values in the Dynamic control panel track the target.
4. Using the double-headed arrow to the top right of the target, toggle to the other threshold.
5. Left click on the target and drag it to the required frequency and boost/cut.
6. Right click on the target and drag the mouse up/down (the target remains still) to increase (narrow) or decrease (widen) the Q factor or choose a shelf response from the EQ slope drop down menu in the Dynamic control panel.

Note: The Q field is disabled when an EQ slope is selected; reset the EQ slope to Off to enable the Q field.

7. If required, fine tune the settings at the PEQ panel by scrolling the Frequency, Level and Q fields.
8. Specify the response to sudden rises in dB level by setting an Attack time between 20 ms and 100 ms using the scroll to increment in allowable steps for the sample rate or by typing in a value (use u for s). Typed in values are automatically adjusted to the nearest allowable value.
9. Specify the response to sudden drops in dB level by setting a Release time between 10 and 2000 ms, using the scroll to increment in steps of 10 ms or by typing in a value.

Adjusting the Dynamics: The target provides coarse visual adjustment, the scrolls enable fine tuning. If you know the exact values you wish to apply to, it may be quicker to type the values into the Dynamic panel. Frequencies in kHz should be entered with a 'k' suffix, that is, 12.5k for 12.5 kHz. Frequencies will be automatically adjusted to the nearest valid increment.

To activate the target on the other Dynamic:

- Click anywhere on its Dynamic panel. The selected panel becomes highlighted and the target cursor switches to the associated Dynamic, on the same threshold as your last edit.
To switch a Dynamic section out of the circuit

1. Tick the Out check box at the bottom right-hand corner of its Dynamic control panel.

The Dynamic is faded to grey on the graph and its contribution is removed from the overall frequency response. The target remains active so that it can still be adjusted while switched out.

2. To switch it in again, clear the check box.

5.4. Filters

To switch to the Filter view

- Click on the Filter button of the Channel A or B Navigation Strip, as required. (If staying on the same Channel, you may prefer to click on a Filter tab).

The upper Filter Mode tab is used to set the bypass state and the Graph display mode (when a DN9340) for the current channel. The lower Filter Shaping tab provides a control panel for each added Filter. Filter settings can also be adjusted at the display by using the target cursor.
At the Filter Mode tab

- Use the Unit Display drop down menu to set the display mode that DN9340 units should assume when taken out of slave operation; this only comes into effect if the slave is a DN9430. The choice made here has no effect on your Add-In device display.

To Bypass all the Filters on the current channel
Tick the Bypass check box in the Filter Mode tab by clicking on it.

To add a Filter to the graph

1. Click on the Add button in the Filter Shaping tab. A notch filter, with target, appears on the left-hand edge of the graph (20Hz) with the target and a filter panel added to the tab.
2. Select a Filter Type from the associated drop down menu on the Shaping tab. The control panel fields change accordingly and the filter (with target) resets to a suitable default freq., for example, if you select LPF the filter resets to 20kHz. To obtain a peaking High or Low Pass filter, select LPF or HPF then select a Peak from the Type drop down menu (right).
3. Left click on the target and drag it horizontally to the required frequency or type in a value using a k suffix for frequencies of 1kHz and above.
4. Set the remaining fields, for example, Level and Slope for a hi-shelf filter. Levels can be coarsely adjusted by dragging the target up or down. Notch filter Q values can be adjusted by right clicking and dragging the mouse up or down.
5. If required, fine tune the settings at the PEQ panel by scrolling the Frequency, Level and Q fields.

To move the target onto a different filter

- Click on the control panel of the required filter. The selected panel becomes highlighted and the target cursor moves to the filter.

To switch a Filter out of the circuit

1. Tick the Out check box at the top right-hand corner of the Filter’s control panel.

   The Filter is faded to grey on the graph and its contribution is removed from the overall frequency response. The target remains active so that it can still be adjusted while switched out.
2. To switch the Filter in again, clear the check box.
6. WORKING WITH MULTIPLE HELIX ADD-INS

6.1. Building your Network Remotely

Working within ELGAR enables you to open a series of HELIX Add-Ins (DN9340 EQ devices) in a single show file to match your physical equaliser network. As with the physical network, the maximum number of devices that can be held in any one file is 32.

In keeping with network protocol, each HELIX Add-In must be assigned a unique network address (between 1 and 32 for the DN9340/DN9344). Addresses do not have to be assigned incrementally, but HELIX RCS will automatically use the lowest available Address when you add-in a new DN9340 EQ Device. HELIX RCS will not allow two devices to be assigned the same address.

6.2. The Fast Navigation Screen

To make it easier to work with multiple HELIX Add-Ins, a global DN9340 Fast Navigation screen is provided with several multi-device facilities, including:

- Switching between the devices
- Copying settings between devices
- Global online controls (covered in Section 7.4)
- Mixing console Solo Tracking button assignments (covered in Section 7.5)
- Function Locking for system Protection (covered in Section 7.6)
- Global memory controls (covered in Section 8)

To switch to the Fast Navigation screen

- Click on the red Fast Nav. button in any HELIX Add-In or maximise the DN9340 Navigation icon on the Windows Start bar.

The screen provides Channel A and B Navigation Strips for all the HELIX Add-Ins in the show file and a series of ‘global’ command buttons. (Only Copy Channels is described here; the other global commands are described in Sections 7 and 8). Channels are identified by the long names entered in the lower Home tab of the respective Add-In and are sorted by Network Address. When there are 10 or more devices in the list the window includes a scroll bar. To the right of each strip is an Online status indicator.

Click on a View button in a channel strip to switch straight to that screen.
To copy settings from one device to another

1. Click on the **Copy Channels** button to open the screen shown below (also see **Note** below). On the left is a list of all the source channels that are available for copying from, while on the right are all the channels that you can copy to. Only Mono channels are shown initially; a mono channel can only be copied to another mono channel and similarly stereo can only be copied to stereo.

2. If required, click on **Show Stereo Channels** to list the stereo channels. (The button toggles to **Show Mono Channels** so that you can return to the previous list when required).

3. Click on the channel to be copied, so that it is highlighted.

4. Tick the **To** check box of each channel to which the settings are to be copied.

5. Choose Apply to apply the changes and keep the screen open for further copying.

   **or**

   Choose OK to apply changes and close the screen.

**Note**
If you see the following message, this feature is not available as there are lock flags active.

**Hint**
If copying basic settings to most channels, use **Select All** to tick all channels in the destination list, then clear check boxes as required. When starting a new selection, use **Reset All** to quickly clear all previous ticks.
7. USING HELIX RCS TO CONTROL AN EQUALISER NETWORK

7.1. Overview

To control an equaliser network, the laptop/PC running HELIX RCS is connected to the network in place of a Master DN9340 HELIX, assuming control of the daisy-chained HELIX units under pre-set slave addresses. The following options for connecting the laptop/PC to the HELIX unit(s) are available:

Serial
- Either RS-485 to the HELIX unit rear panel or RS-232 to the HELIX PC port on the front panel.

Ethernet
- Covers direct Ethernet, Local Area Network or wireless connection, converting to either a RS-485 rear panel input or RS-232 front panel input via a Lantronix UDS 100 Converter. Wireless offers increased flexibility during the event set-up, as the engineer can move around freely with a laptop and adjust the equalisation while listening to the end effect at any place in the venue.

For details on connecting the HELIX units together, please refer to the DN9340/44 operators manual; the following sections describe how to connect the master HELIX RCS laptop/PC to the slave network for each option.

Note
If Solo Tracking input is required, the first slave HELIX must be a DN9340 and the front panel RS-232 PC Port must be used.

7.2. Serial Connection

7.2.1 Equipment Requirements

The system set up for serial connection is illustrated below.

Notes:
1. If Solo Tracking is not required, the first HELIX unit can be a DN9344.
2. RS-232 connection is via front panel PC Port. RS-485 connection is via the COMMS IN XLR socket on rear panel.
Cable and converter requirements are dependent on the available connections at the laptop/PC as detailed in the following table. The associated Comms Mode for the HELIX RCS is also shown.

<table>
<thead>
<tr>
<th>HELIX Connection</th>
<th>Laptop/PC Connection</th>
<th>Cable /Converter Required</th>
<th>Comms Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 input to Front panel PC PORT for short cable run or Solo Tracking</td>
<td>D9 COM Port</td>
<td>Host cable</td>
<td>Generic Echo On</td>
</tr>
<tr>
<td></td>
<td>USB Port</td>
<td>KK systems USB/232 converter plus host cable</td>
<td>Generic Echo On</td>
</tr>
<tr>
<td>RS-485 input to rear panel Comms In XLR for long cable run</td>
<td>D9 COM Port</td>
<td>RS-232/485 converter, for example, KT LBB-485 powered from PS2 mouse port Or KK systems K3-ADE plus power supply*</td>
<td>KT LBB-485</td>
</tr>
<tr>
<td></td>
<td>USB Port</td>
<td>B+B Electronics USOTL4</td>
<td>Generic Echo Off</td>
</tr>
</tbody>
</table>

*For full details of recommended converters and pinout connections please refer to the KlarkTeknik website at [http://www.klarkteknik.com/faq_connections.htm](http://www.klarkteknik.com/faq_connections.htm).

7.2.2 Connection Procedure

The HELIX RCS laptop/PC is connected to the daisy chain as follows:

- **To connect your laptop/PC to the HELIX network:**
  1. Connect, power up and set up the addresses of the slave HELIX units in a daisy chain network (refer to in the DN9340 Operators Manual). If using Solo Tracking, the ‘first’ HELIX in the daisy chain must be located in the FOH stack for connection to the console.
  2. Referring to 7.2.1 Equipment Requirements, connect your laptop/PC to the first HELIX unit in the daisy chain as relevant to your specific system set up.
  3. Boot up (or re-boot) your laptop/PC.

  **Important!**
  If the connection is made to an already running laptop/PC, you must re-boot to ensure the new COM or USB port is reliably recognised. This is a limitation of the Port devices.

  4. Open ELGAR by double-clicking on the ELGAR desktop icon.
  5. Select File > Open from the ELGAR menu to locate and open the KTG show file containing the HELIX unit settings.
  6. In the upper Home tab of each HELIX Add-In, specify the Address of the slave unit that the Add-In should control and specify the RS-232 or USB COM Port number. Set the Comms Mode to Klark Teknik if using an LBB-485 converter or Generic Echo On if using either a third party RS-232/RS-485 converter or the standard HELIX cable to the front panel.

You system should now be ready for online operation, as described in Section 7.4.
7.3. Ethernet Connection

7.3.1 Equipment Requirements

The system set up options for Ethernet connection are illustrated below. Note that for Ethernet connectivity, the HELIX units must be operating V3.03 (or later) host code.

Notes:
1. If Solo Tracking is not required, the first Helix unit can be a DN9344.
2. RS-232 connection is via front panel PC Port. RS-485 connection is via the COMMS IN XLR socket on rear panel.
For Ethernet connection to a HELIX unit/network the following is required:

**Important!** For Ethernet connectivity, the HELIX units must be operating V3.03 (or later) host code.

- A Lantronix UDS 100 IP-to-Serial Converter is required to convert between Ethernet IP and RS-232 or RS-485 at the HELIX Unit. This converter and associated cable may be obtained through Klark Teknik. If making your own cables, pinout connections should be made as detailed in the table below. Other IP-to-serial converters are not supported by Klark Teknik for this set up, as their performance does not meet the requirements of this application.

- UDS 100 Converter to HELIX Cabling as detailed in the table below. The associated Comms Mode for the HELIX RCS is also shown.

<table>
<thead>
<tr>
<th>UDS 100 to Helix Connection</th>
<th>Cable/Converter Required</th>
<th>Pinouts</th>
<th>Comms Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RS-232 input</strong> to Front panel PC PORT for short cable run or Solo Tracking</td>
<td>Male D25 to Male D9 cable plus D9 COM Port Host cable¹</td>
<td>D25 Pin 2 Tx Pin 3 Rx Pin 7 Gnd</td>
<td>Generic Echo On</td>
</tr>
<tr>
<td><strong>RS-485 input</strong> to rear panel Comms In XLR for long cable run</td>
<td>Male D25 to XLR cable¹</td>
<td>D25 Pin 7 Gnd Pin 14 Tx+ Pin 21 Rx+ Pin 15 Tx- Pin 22 Rx- tied</td>
<td>Generic Echo Off</td>
</tr>
</tbody>
</table>

1: If making you own cables, pinout connections should be made as shown.

- Laptop/PC to UDS 100 Converter cabling or equipment for wireless connection, as detailed in the following table.

<table>
<thead>
<tr>
<th>Laptop/PC to UDS 100 Connection</th>
<th>Cabling/Equipment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Ethernet</td>
<td>CAT5 crossover cable</td>
</tr>
<tr>
<td>Corporate LAN</td>
<td>CAT5 cable to and from LAN connection point (Refer to your IT department for configuration details of the LAN to allow routing of UDS 100 messages from your PC to the UDS 100)</td>
</tr>
<tr>
<td>Wireless¹</td>
<td>IEE 802.11b/g-compatible Wireless Ethernet card IEE 802.11b/g-compatible Wireless Ethernet Access Point CAT5 ETHERNET cable²</td>
</tr>
</tbody>
</table>

1 For wireless set up, the laptop/PC must be capable of 802.11b or 802.11g format communication.

2 With wireless, the UDS 100 Converter will work with either straight through or crossover CAT5 cables as the Access Point automatically detects which type is currently connected.
7.3.2 Configuring the Network Devices

Before setting up the Ethernet system for operational purposes, you first must configure the network devices, that is, the UDS 100 Converter and laptop/PC to communicate with each other using TCP/IP protocol. This is done by assigning them unique IP addresses on a shared network.

LAN and wireless connections require additional routing information. For LAN, this must be provided by the Network Administrator. Wireless routing is described below.

IP Addressing

To uniquely identify every device, Ethernet connections use standard IP addresses, comprising four 0-255 segments presented in dot notation, for example, 192.168.1.16. To accommodate widely varying sizes of network, including those with sub-networks, the segments can be used in slightly differing ways. The format used by a particular IP address is defined by its ‘subnet mask’, as follows:

On a small ‘Class C’ network (less than 256 devices), the subnet mask is 255.255.255.0 indicating that the first three segments identify the network and are shared by all of the equipment on the network, while the last segment uniquely identifies each device, for example, in 192.168.1.16, the network subnet is 192.168.1 and the Device ID is 16. Typically, this is the subnet mask used for IP addresses on a HELIX RCS network.

For larger networks, the first one or two segments identify the network and the remaining segments identify the sub-network, if relevant, and individual equipment. For example, a Class B medium sized network uses a 255.255.0.0 subnet mask, indicating the first two segments identify the network and the last two the sub-network and individual device.

Wireless Routing

For wireless connection, the Laptop/PC wireless card and Access Point must be set up to locate and recognise each other, bearing in mind that the airwaves are shared with other devices. This is done by initially making a wired connection from the laptop/PC to the Access Point to assign the appropriate identifiers etc. After configuration, the wired connection can be removed and the wireless one made. There is no need to repeat the wired connection step on future set ups, provided no part of the wireless system has changed.

Two identifiers are used in the recognition process, as follows:

- **Service Set Identifier (SSID)** – The Access Point broadcasts this to enable nearby devices to locate it. Broadcast may be disabled, so that the Access Point only flags its presence when another device calls it by name, that is, its SSID. This mode should be used for the HELIX RCS wireless connection to provide security against unauthorised users accessing the network.

- **Authentication code** – This ensures that the device trying to connect to the Access Point has the right to access the network, thus providing an extra layer of security against unauthorised users. Although there are various authentication methods, the worked example in the next section specifically covers the basic Wireless Equivalent Privacy (WEP) key scheme, which uses a long sequence of numbers as the key. If you wish to use a more complex scheme, please consult the Access Point and wireless Ethernet card manuals.

In addition, the broadcast channel of the Access Point can be specified (typically channels 1 to 11 are available); this is particularly useful if there are other Access Points in the vicinity.

**Note**

Every Ethernet connection on your Laptop/PC has a different IP address. Therefore, when you have both wired and wireless Ethernet cards on your laptop/PC, be sure to enter the correct settings for each.
To configure an Access Point and wireless card (wireless set up only):

As set up procedures vary between the commercially available Access Points, and your Access Point may have a Set Up Wizard, only essential guidelines can be given here. (Some Access Points store their configuration details on a web page of the same IP address.) Please refer to your product User Guides to ensure correct wireless operation. Also, operating Systems vary amongst users only; therefore only standard Windows XP wireless configuration screens are covered here. These can generally be related to screens on other operating systems.

Access Point

1. Referring to the product’s manual, set up the Access Point to communicate with your laptop/PC, ensuring you use the following:

   **IP settings:**

   Set the Access Point IP address to the same IP subnet value as your laptop/PC LAN and wireless card.

   **Note** Your Access Point will have a factory preset IP subnet address, so to locate it initially you may be asked to temporarily reconfigure your laptop/PC to use the same IP subnet address. After you have located and reconfigured the Access Point to work on your normal laptop/PC IP subnet, remember to reset your laptop/PC to its normal IP address.

   **Wireless Network Settings:**

   Set an SSID (Service Set Identifier) and disable SSID Broadcast. (If you are given the option to 'name' the Access Point in the configuration details, it can be helpful to also use the SSID as the name.)

   Choose a Broadcast Channel to minimise interference with other nearby Access Points. To avoid interference, Channel numbers should differ by at least 5. Therefore, as most Access Points default to Channel 11, Channels 1 – 6 are likely to offer the least interference from other devices in the area.

   **Security Settings:**

   For choosing the Network Authentication type, refer to the product manual or use 'Open System'.

   Set the Data encryption to WEP (Wireless Equivalent Privacy) using, for example, 128 bits, and generate a key. Usually you are asked to enter a phrase from which the key will be generated. Make a note of the WEP key and keep it in a secure place (remember the WEP key is the security code for your wireless network).

Help

If your laptop appears to have problems talking to the network equipment, try ‘Pinging’ it using the DOS Command Prompt ‘PING’ followed by the IP address, for example, PING 192 168.1.10. If it says it cannot reach it, rather than having timed out, then they are not using the same IP subnet address – check that you have changed your laptop IP address back to its original setting. If that’s not the problem, check that the Access Point was configured correctly.
2 Open your laptop/PC’s Control Panel and locate and open the Wireless Network Connection Properties dialogue box. If your wireless card is set up to use Windows to configure its wireless networks, a screen similar to that shown left is presented that has a Wireless Networks tab. Follow the steps given here to configure the card.

If the Wireless Networks tab is not available, please refer to the wireless card manual for configuration instructions. Make sure that you use the SSID and WEP key from the Access Point Configuration.

3 Highlight Internet Protocol (TCP/IP) in the list and choose Properties to open the Internet Protocol Properties screen (left). If you are using DHCP refer to your Access Point manual for details. Otherwise, select Use the following IP address and type in an IP Address for your wireless card using the same subnet address as your Access Point and laptop.

Click OK to return to the previous screen.

4 Switch to the Wireless Networks tab (left). Tick Use Windows to configure my wireless network settings. (The SSIDs of previously added networks automatically appear in the network lists.)

5 At the bottom panel, click Add to open the screen shown.

6 Type in the SSID address of the Access Point and turn WEP on. Set Key Index to 1.

Clear The key is provided for me automatically tick box to unlock the Network key fields. Type in and confirm the WEP key as noted in the Access Point configuration.

7 Click OK to confirm the settings and close the Wireless Network Connections screen.
8 The Access Point SSID should now appear in the lower Preferred Networks list. If necessary, move the network SSID to the top of the list, using the Move Up button, so that Windows automatically connects to it in preference to other available networks.

9 Highlight the SSID in the lower list and click Refresh in the upper panel. After 1-2 minutes, (depending on signal strength and quality), Windows should pop up a notification box to show that it has found a new network. The SSID should now appear in the upper Available Networks list, with an active transmitter symbol (as shown).

If the Access Point SSID is not yet visible in the Available networks list, refer the Help box below.

10 Click OK to exit the dialogue box.

Help

The Access Point SSID may take some time to register in the Available networks list, as the Access Point must complete a re-boot to effect the configuration changes. Try refreshing again but this time exit the dialogue box by clicking OK. Wait at least 2 minutes to ensure the Access Point re-boot has had time to complete, and then re-open the Wireless Network Connections Properties dialogue box.

If the SSID still does not appear, open up the Network Connections window from the Control Panel and ensure that the wireless connection is shown and not disabled. If it is correctly enabled and you cannot make the connection, refer to your wireless hardware equipment manuals for help.
To configure your UDS 100 Converter (all Ethernet setups)

Please note that the instructions given here relate to the Lantronix Device Installer V3.6, which has the advantage of automatically locating your UDS 100, even if the factory set IP subnet address does not match your laptop IP subnet. If your Device Installer is an earlier version please download the latest version from the Lantronix website at http://www.lantronix.com/support/utils/dst.

1. Connect the device to your laptop/PC or if you are setting up a Wireless Network to connect it to the Access Point.

2. Install the Lantronix Device Installer (V3.6 or later).

3. Open the Windows Start>All Programs menu and select the Lantronix > Device Installer application. The screen shown left is opened.

4. Choose Search to locate network devices.

**Note:** On the initial search, the Device Installer will find the device regardless of whether it is currently on the same subnet IP address as your laptop/PC.

5. Highlight the UDS 100 in the device list and choose Assign IP to open the Assign IP Address Wizard.

6. **LAN connection:** Refer to the Network Administrator for guidance on whether to obtain an IP address automatically or assign a specific IP address. Follow the on-screen instructions to complete the assignment.

   **Direct or Wireless:** Choose Assign a specific IP address and click Next. Follow the on-screen instructions, entering an IP address on the same subnet as your laptop/wireless card and leaving the Default Gateway value at 0.0.0.0.

7. On completion, click Finish to return to the Device Installer screen.
8 Highlight your device in the list, choose Configure to open the Configure Device screen.

(Additional icons appear now that the IP address has been changed to match the subnet of the laptop).

9 Switch to the Ports tab. Select Port 1 and click on Edit Settings. Port 2 is not used by the UDS 100 Converter.

10 Enter the following values in the Port Settings tab:

- Baud Rate: 38400
- Data bits: 8
- Parity: None
- Stop bits: 2
- Flow control: None

Click OK to return to the Ports tab.

Click Apply, then click OK to return to the Device Installer screen.

11 With your device still highlighted in the list, choose Web to link to the configuration web page of the device.

12 In the web page, set the Serial Protocol to RS-485 or RS-232 as appropriate to your set up. Click Update Settings and wait for the device to reboot.

Note: With Solo Tracking you must use the front panel RS-232 input for the Converter.

13 Close the web browser and the Device Installer.

Important! Remember to change the Serial Protocol if you change from RS-232 to RS-485 input or vice versa.
To configure the Virtual COM Port (all Ethernet setups)

1. Install Lantronix Com Port Redirector software on your laptop/PC. The software may be obtained from the Lantronix website at: http://lantronix.com/support/download/index.html#soft

2. After installation, select the Start>Programs>Lantronix Redirector>Configuration application. The RDCFg screen shown below is displayed.

3. Ensure that Silent Mode is disabled, that is, the check box is empty.

4. Click on Add IP to open the IP Service Set up screen. Type the IP address of the Lantronix UDS 100 Converter into the Host field and enter the TCPPort number from the configuration web page, that is, 10001. Click OK to return to the RDCf screen.
   (A different TCPPort may be assigned, provided you change the setting in the UDS 100 web configuration page.)

5. Click on Com Set up to open the Port Set up screen. Select a port number for your virtual COM port by ticking its checkbox. Click OK to return to the RDCf screen.

6. Click on Port Settings. Tick Timeout Reconnect and Raw Mode and clear the remaining fields (see right). Set the Connection Timeout to 10ms. Click OK to return to the RDCf screen.

7. Click Advanced to open the Advanced Settings screen. Type in 7 200 000 ms for the TCP Keep Alive time and tick Run as service. Click OK to return to the RDCf screen.

8. At the RDCf screen, Save the settings then Close.

9. Re-boot the laptop/PC to activate the virtual COM port.
7.3.3 Connection Procedure
For an overview of the connections, please refer to the Ethernet system set up illustration at 7.3.1.

To connect up a HELIX RCS Ethernet System:

1. Connect, power up and set up the addresses of your slave HELIX units in a daisy chain network as described in the DN9340 Operators Manual. If using Solo Tracking, the 'first' HELIX in the daisy chain must be located in the FOH Stack for connection to the console.

2. Connect the UDS 100 Converter to the first HELIX, as follows:
   - For RS-232 communications (for example, when using Solo Tracking), use a male D25 to male D9 cable joined to the host cable (female D9 to 9-way mini DIN) to connect the serial port of the Lantronix UDS 100 Converter to the PC port on the front panel of the first HELIX unit in the daisy chain.
   - Or
   - For RS-485 communications, use a male D25 to XLR cable to connect the UDS 100 Converter to the Comm In XLR plug on the rear panel of the first HELIX unit in the daisy chain.

   Important! Ensure that the Serial Protocol is set correspondingly to RS-232 or RS-485 in the Lantronix Configuration web page. To view the page, enter the IP address of the UDS 100 box into the web browser address field.

3. Connect the UDS 100 Converter as follows:
   - Direct: Use CAT5 crossover cable to connect the UDS 100 RJ-45 port to the laptop/PC RJ-45 port.
   - LAN: Use CAT5 cable to connect the RJ45 port on the UDS 100 to its network connection point. Similarly, use CAT5 cable to connect the laptop/PC RJ-45 port to its network point.
   - Wireless: Position the Access Point to maintain line of sight visibility to your laptop as you move around the venue during the sound testing, while remaining in the Access Point’s radio limits, for example, use a high up location, generally no more than 100 m from the furthest sound testing position. Connect power to the Access Point as indicated in the product manual.
   - Use CAT5 cable to connect the UDS 100 RJ-45 port to the Access Point RJ-45 (LAN) port.

4. Using the provided AC power adapter, connect power to the Lantronix UDS 100 Converter.

5. Boot up (or re-boot) your laptop/PC and open ELGAR by double clicking on the ELGAR logo desktop icon.

6. Select File > Open from the ELGAR menu and open the .KTG show file with the HELIX settings. ELGAR initiates the Ethernet connection and reports success or failure. If it fails, see Section 7.3.4 Fault Finding Tips.

7. In the upper Home tab of each HELIX Add-In:
   - specify the Address of the slave unit that the Add-In relates to
   - set COM Port to the number you allocated to the Virtual COM Port
   - set Comms Mode to Generic Echo On for RS-232 or Generic Echo Off for RS-485 input to the first HELIX.

Your system should now be ready for online operation, as described in Section 7.4.
### 7.3.4 Fault Finding Tips

The following tips cover some of the more likely errors in an Ethernet set up that will cause ELGAR to report a failure in establishing a connection with the HELIX network. If none of these solve the problem, please refer to your LAN administrator or the fault finding guidance in the your wireless equipment manuals. To contact Klark Teknik Service Support, please refer to our website at [http://www.klarkteknik.com/](http://www.klarkteknik.com/).

#### If your Ethernet connection failed when you opened HELIX RCS:

1. Select **Start>Programs>Accessories>Command Prompt** to open the DOS Command prompt. Verify the network connections and addressing as follows:

   Verify the status and IP addresses of the LAN card and wireless card by typing `IPConfig`. If the prompt returns, “Media disconnected”, you need to re-enable the LAN or Wireless Network Connections in the Control Panel. If IP addresses are successfully found, verify that their IP Subnet is correct; if not, change the IP address in the Control Panel.

   Verify that the laptop can see the UDS 100 box and Access Point (if relevant) by Pinging their addresses, that is, type `PING` followed by the IP address at the `C>` prompt and press `[Return]`. If there is no reply, you may have entered the IP address incorrectly at the configuration stage – refer back to the configuration instructions.

2. Open the Lantronix configuration web page by entering the IP address of the UDS 100 box in the web browser address field. Ensure that the Serial Protocol is set to match your cabling, that is, RS-232 or RS-485, as appropriate.

3. Re-boot your laptop. (It is important that the laptop is re-booted after the system has been connected and powered up, especially if you have changed the set up to/from wireless).

4. Verify that all cabling and power connections are in place and, where relevant, that the Access Point is in a suitable location.

5. Ensure that the Helix Units are operating on host code V3.03 or later.

6. Check the Activity LEDs at the UDS 100 box and refer to the product manual for indications shown by Activity LEDs.
7.4. Working Online

7.4.1 Communications Overview

Referring to the illustration above, in online mode the HELIX RCS laptop/PC and slave units exchange the following messages:

- **Metering Requests and Responses**: These obtain data for the Input, Dynamic EQ and Output ‘LED’ meters of HELIX RCS screen. The HELIX RCS continually polls the units in rotation.
- **Get All Requests and Responses**: These obtain settings from the specifically addressed unit. These may be initiated by the user or automatically by the HELIX RCS.
- **Data Packets**: These carry the equaliser settings from the laptop/PC to the specifically addressed units. Data Packets are only transmitted when you make changes at the laptop/PC.

What happens when there is interruption to the wireless connection

If the wireless connection drops (for example, due to a pillar interrupting the radio signal), the HELIX RCS suspends the Add-In settings so that no further changes can be made, although you may freely navigate between screens. Due to the network speed however, there will be a small delay during which you may make some changes that are not registered at the unit.

During the drop, the HELIX RCS continues to poll the units for metering requests. When a response is detected, that is, the wireless connection is restored, the HELIX RCS will come back online as follows:

**If you were making changes when the connection dropped**, that is, data packets were lost, the HELIX RCS will send a Get All request to the slave network to re-synchronise the HELIX Add-Ins with their physical counterparts before unfreezing the Device Screens. Your last change(s) are lost. Synchronising to the physical units, that is, to the last settings you heard, avoids the possibility of extreme changes in volume due to any dramatic adjustments you may have made due to the apparent lack of effect as the units went offline.

**If no changes were being made when the units went offline**, that is, no data packets were lost, the HELIX RCS has no need to re-synchronise and smoothly reverts to normal operation without sending a Get All request.

**Note**: Normally, the Get All request overwrites the ‘Mute On’ settings at the RCS. However, if the Get All is initiated automatically due to signal interruption, active Mute buttons retain their status while the gain value at the unit is transferred to the Level field. This enables Mutes to be applied to channels for sound testing purposes while ensuring their true levels are not lost during signal interruptions.
7.4.2 Online Operation

**Important!**
We recommend that you always save your show file settings before going online, so that you have the option of reverting to previous settings after a ‘Get All’ synchronisation.

The slave Units in the network can be set online/offline, individually or globally, as required.

**To set a particular unit online (and Get All/Send All settings)**

1. Switch to the respective HELIX Add-In.
2. Click on the large red **Go Online** button to the right of the Channel Navigation Strips.
3. At the Synchronise Data prompt, choose to download the PC settings to the Unit (Set All), or upload settings from the Unit to overwrite the current PC settings in the respective Add-In Devices (Get All).
4. Click **OK**.

When contact is successfully established the button turns green and the text changes to **Go Offline**, while at the HELIX unit the alphanumeric shows T/R activity. If the connection is not immediate the button turns yellow and displays a ? while it tries to establish wireless contact.

---

**Version Update**

In response to customer feedback, the online/offline colour coding has been reversed from earlier versions. Also, the data synchronisation ‘direction’ has been changed; ‘Get All’ is now the default option.

If online contact cannot be established, an error message is returned. This must be acknowledged; thereafter HELIX RCS will continue polling the unit unless taken Offline by clicking on the yellow ? button. Continuous polling is primarily designed to facilitate wireless communication, where the link may briefly disappear, for example, when you walk behind an obstructing object. However, it can also be useful when fault finding cabled communication, as the button will turn green as soon as the problem is corrected.

**Warning!**
Changes should not be made to equalisation settings at the unit while the HELIX RCS is attempting to establish communication, as this the Unit and Add-In may lose synchronisation.
If online communication cannot be established, check the following:

- The Add-In device is set to a valid Address, COM Port and Comms Mode in the upper Home tab.
- Cabling and power connections are in place.
- Network communications are operating correctly (Ethernet setups only) – refer to 7.3.4 Fault Finding Ethernet Communications.

To take a unit offline

1. Switch to the respective HELIX Add-In.
2. Click the green Go Offline button so that it toggles to red Go Online.

To check the status of online status of the Devices in the network

- Switch to the Fast Navigation screen. The status of each channel connection is indicated at the right of the Navigation Strip by a green (Online), red (Offline) or a yellow (trying to establish connection).

To set the entire network online

1. Switch to the Fast Navigation screen.
2. Choose All Units Online or All Units Offline, as required.
3. At the Synchronise Data prompt, choose to download the PC settings to the Units (Set All), or upload settings from the Units to overwrite the current PC settings in the respective Add-In Devices (Get All).
4. Click OK.

The HELIX RCS will poll the networked Units in order of the Fast Navigation list, bringing the respective Add-In to the foreground and updating their Online/Offline buttons as the poll proceeds. A Please Wait window shows the current progress.

If a unit communication cannot be established with a unit after a few seconds, a prompt will advise you to set the unit offline to enable the system to run faster (if left online it will be continually polled for connection and this will slow the system). To help maintain optimum performance in a busy situation, this prompt has a countdown whereby the Unit is automatically taken offline if there is no acknowledgement.
To cancel online connection during polling

- Close the Please Wait window by click on the ✗. You will be prompted to confirm the action. Click Yes to cancel or No to resume the poll.

To take the entire network offline

1. Switch to the Fast Navigation screen by clicking on the red Fast Nav. button in any Add-In or by maximising the DN9340 Navigation icon on the Windows Start bar.
2. Choose All Units Offline.

The buttons on the Fast Navigation and individual Device screens are toggled accordingly.

7.4.3 Activity Indicators

During online operation, the Activity Indicators of the HELIX Add-In provide audio metering for the respective unit. These mirror the Activity Indicators of the Unit (for further information on metering, refer to the DN9340/DN 9344 manual).

7.4.4 Bypassing Channels

Using HELIX RCS as the Master enables Channels, EQ types or EQ sections/filters to be quickly switched in and out, as follows:

<table>
<thead>
<tr>
<th>To Bypass...</th>
<th>From the Fast Navigation screen...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A channel</td>
<td>1. Select the Home view of the channel.</td>
</tr>
<tr>
<td></td>
<td>2. Tick the Bypass box in the highlighted panel of the lower tab (that is, the active channel).</td>
</tr>
<tr>
<td>A EQ type</td>
<td>1. Locate the required channel Navigation Strip and click on the required EQ view button.</td>
</tr>
<tr>
<td></td>
<td>2. Tick the Bypass box in the upper mode tab.</td>
</tr>
<tr>
<td>EQ section</td>
<td>1. Locate the required channel Navigation Strip and click on the required EQ view button.</td>
</tr>
<tr>
<td></td>
<td>2. Tick the Out check box for the respect EQ section/filter in the lower tab.</td>
</tr>
</tbody>
</table>
7.5. Solo Tracking Operation

If required, the Solo Tracking system of the Midas mixing console in use can be set up to select the slave equalisers in the Helix Network. To enable this, the various Solo Tracking buttons must be assigned to Helix channels via the System Solo Tracking Setup screen (shown below) and the settings downloaded to a DN9340 Helix unit that is currently connected to the console Solo Tracking output (the DN9344 does not have a Solo Tracking input).

To open the System Solo Tracking Setup screen:

- Switch to the Fast Navigation screen and choose Solo Tracking.

The screen contains a scrollable list similar to the Solo Tracking System Configuration page of the DN9340 Helix unit, showing the 32 HELIX equaliser channels and their currently assigned solos. Assignments are made via the fields in the Solo Tracking Setup panel at the right-hand side. The available Solo Source and Num settings change to match the chosen Console Type.

To assign solo sources to HELIX channels:

1. Specify the console to be used for the performance in the Console Type field in the top right-hand corner of the screen. Any current assignments that are not valid for the chosen console are flagged as invalid by an asterisk in the right-hand column.

2. Highlight the HELIX channel in the list and choose the required Solo Source from the drop down list on the right-hand panel and then choose a number from the Num drop down list. (The Num list changes to suit the selected Solo Source).
3 If an asterisk appears in the **Valid** column, the chosen solo button is already assigned to another HELIX channel; the conflicting HELIX channel will also be marked with an asterisk. Select another **Solo Source** and **Num** combination for one or other of the HELIX channels to resolve the conflict.

**Hint** If required, click on **Reset STS** to quickly clear all the current solo assignments.

To write the settings to the DN9340 unit that is currently configured for Solo Tracking

1 In the System Solo Tracking Setup screen, select the DN9340 HELIX unit you wish to write to from the **Target Helix Unit** drop down list. The **Target Helix** field defaults to the Master Unit specified in the Function Lockout screen (see Section 7.6).

2 Click on **Write To Unit**. You are warned that this will overwrite the data in the unit and are asked to confirm the action.

**Note** If the **Write To Unit** button is dimmed, you need to set the selected target unit online.

3 Click **Yes** to continue or **No** to abort.

4 Click **Exit** to close the screen when finished.

### 7.6. Protecting System Settings

To protect against unauthorised users tampering with key parameters that may affect preset room equalisation or result in equipment damage, a password protected lockout can be set up via the HELIX RCS show file using the screen shown below. The lockout settings and password are downloaded to a specified master unit, generally the DN9340 HELIX with Solo Tracking, such that the system is still protected when taken out of remote control.

**To open the System Solo Tracking Setup screen:**

- Switch to the Fast Navigation screen and choose **Function Locking**.

---

### To write the settings to the DN9340 unit that is currently configured for Solo Tracking

1 In the System Solo Tracking Setup screen, select the DN9340 HELIX unit you wish to write to from the **Target Helix Unit** drop down list. The **Target Helix** field defaults to the Master Unit specified in the Function Lockout screen (see Section 7.6).

2 Click on **Write To Unit**. You are warned that this will overwrite the data in the unit and are asked to confirm the action.

**Note** If the **Write To Unit** button is dimmed, you need to set the selected target unit online.

3 Click **Yes** to continue or **No** to abort.

4 Click **Exit** to close the screen when finished.

### 7.6. Protecting System Settings

To protect against unauthorised users tampering with key parameters that may affect preset room equalisation or result in equipment damage, a password protected lockout can be set up via the HELIX RCS show file using the screen shown below. The lockout settings and password are downloaded to a specified master unit, generally the DN9340 HELIX with Solo Tracking, such that the system is still protected when taken out of remote control.

**To open the System Solo Tracking Setup screen:**

- Switch to the Fast Navigation screen and choose **Function Locking**.

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Lockout settings are downloaded to the master unit, e.g. the Solo Tracking DN9340.**

- **Graphic, Parametric and/or Dynamic EQ settings can be locked out separately.**

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Settings are protected by password access.**

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Lockout settings are downloaded to the master unit, e.g. the Solo Tracking DN9340.**

- **Graphic, Parametric and/or Dynamic EQ settings can be locked out separately.**

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Settings are protected by password access.**

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Lockout settings are downloaded to the master unit, e.g. the Solo Tracking DN9340.**

- **Graphic, Parametric and/or Dynamic EQ settings can be locked out separately.**

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Settings are protected by password access.**

---

![Function Lockout Screen](image.png)

- **Function Lockout** screen showing lockout settings and password.

**Lockout settings are downloaded to the master unit, e.g. the Solo Tracking DN9340.**

- **Graphic, Parametric and/or Dynamic EQ settings can be locked out separately.**
Initially, when you open the screen the fields will be dimmed out. To access the fields you must enter
the current password. Once accessed, you can:

- Lock out all or some of the EQ screens for all add-ins (and equivalent Unit menu pages via
  Master Unit).
- Freeze the Delay and Gain settings for all add-ins (and equivalent via Master Unit).
- Secure linked channels settings.

To change lockout settings:

1. Type in the password and click **Enter Password**. Provided you entered the correct password, the
   fields will become active. If the password is incorrect, an error prompt is displayed and another
   attempt may be made.

   **Note** If you have not previously set a password this will default to ‘password’ (all lower
   case). Password traffic is one way only from the HELIX RCS to the Master Unit; they
   are not uploaded with the Get All data command.

2. If necessary, select the **Master Unit** from the associated drop down list. Helix RCS will confirm the
   change has been made. Click **OK** to continue.

3. Tick the check boxes of the locks you wish to apply.

4. Click **OK**.

To change the current password:

1. Click on **Change Password** to open the screen shown right.

2. Type in a password of up to 8 characters in length. Note that the DN9340 Unit regards spaces as part of the
   password.

3. Repeat the password in the lower field to confirm it and click **OK**.

Provided the passwords in both fields match, Helix RCS will confirm the change. If there was a mismatch, the change will fail.
8. STORING/RECALLING MEMORY SETTINGS

The DN9340 and DN9344 HELIX Equalisers are provided with 32 User memories for storing frequently used Equaliser settings in battery-backed-up SRAM. In addition, they have 32 password-lockable Preset Memories stored in non-volatile FLASH memory for secure storage of essential settings against overwriting or battery failure; these can only be programmed using an external computer.

To enable you to quickly program both User and Preset memories, the HELIX RCS Add-In device has 64 equivalent ‘PC memory’ locations in which you can create and store varying equalisation settings for downloading to the physical unit. Alternatively, memories can be uploaded from the Unit to the equivalent PC locations.

The memory settings of a HELIX Add-In are viewed, edited, stored and recalled to/from Unit Memories in the Memory view. (Memory is not included as a button on the channel Navigation Strips as memory settings apply to the unit as a whole). For simplified global management, you can also read and write memories to/from multiple Units using the Memory Management Command of the Fast Navigation screen.

8.1. Memory Working with Individual Add-Ins

- To switch to the Memory view
  - Click on either the upper or lower Memory tab of the Add-In device.

The graph of the Memory view is the same as the Home view, that is, it shows the overall frequency response of the current PC memory, which initially defaults to Memory 1 (equivalent to U01 at the Unit). The upper Memory tab shows the currently selected PC Memory while the lower Memory tab contains the online store and recall commands.
To remotely program equalisation settings in another PC Memory location

1. Select a memory location from the **Current PC Memory** drop down list in the upper memory tab. If you are currently online, you will be warned that switching memory will force the unit offline and then asked to confirm the action.

2. Click **OK** to continue. The frequency response will be updated with the settings held in the selected PC memory.

3. Shape the frequency response of the new memory location, as required, using the various Equalisation tabs and working on or offline as appropriate.

**Notes**

- **If you go online and choose to Set All initial values from the PC** - The settings of the PC memory will be transferred to the active ‘scratchpad’ at the slave Unit but they do not overwrite the stored memory settings. The memory location on the graphic display refers to the last memory recalled to the scratchpad. Hence, you can program PC memories on the scratchpad without destroying stored Unit memories. Memories are only overwritten by a Store or Write All command.

- **If you go online and choose to Get All initial values from the Unit** - The active settings of the Unit will overwrite the settings in the current PC memory at the Add-In Device.

To name a PC memory for reference purposes

1. Type in a name, maximum 20 characters, in the **Memory Name** field. Note that certain symbols are not allowed, for example, % and £. The name will be appended to the number in Current PC Memory field and will be downloaded to the unit under the Store command.

When a memory is recalled at the Unit to the active ‘scratchpad’, the name appears in the Unit’s alphanumeric display.

To store the Current PC memory to a User memory at the HELIX Unit

1. Set the HELIX Add-In online.

2. In the lower Memory tab’s middle panel, select the User Memory in which you wish to store the settings using the respective drop down list.

3. Click on **Store User Memory**. You are warned that the current memory will be overwritten, and asked to confirm the action.

4. Click **OK** to continue or **Cancel** to abort.

**Note**

Settings cannot be sent to the unit Preset memories on an individual basis. To store a Preset memory you must use the write all command - this downloads each PC memory to the equivalently numbered Unit Memory, thus providing an extra safeguard against accidentally overwriting essential settings.
To recall settings from a User or Preset memory from the HELIX Unit to the Add-In Device

1. In the upper Memory tab, select the Current PC Memory that you wish to overwrite.
2. Set the Add-In Device online.
3. In the lower Memory tab’s left-hand panel, select the required Unit Memory location from the associated drop down list. (The Current PC Memory No. is not affected by the recall Unit’s memory number since only the settings are recalled.)
4. Click on Recall Unit Memory. You are warned that the current memory will be overwritten, and asked to confirm the action.
5. Click OK to continue or Cancel to abort.

The memory settings are uploaded to the Current PC Memory and the graphic display is updated. The recalled frequency response can now be edited by changing the settings in the various Equalisation tabs, working on or offline as appropriate.

To retrieve all the Memories from a Unit to the Add-In Device

1. Set the Add-In Device online.
2. In the lower Memory tab’s right-hand panel, select Read All Memories.
3. Click OK at the prompt to confirm the overwriting of the PC memories.

As retrieving all 64 memories takes a couple of minutes, the HELIX RCS presents a Status window so that you can track the current progress. When the operation is complete, the Status window disappears.

To write all the Memories from the Add-In Device to the unit

1. If you wish to write settings to the Preset memories, ensure they are unlocked at the Unit. (If they are locked, only the User memories will be overwritten).
2. Set the Add-In Device online.
3. In the lower Memory tab, select Write All Memories.
4. Click OK at the prompt to confirm the overwriting of the Unit memories.

PC memories are sent in numerical order such that the User Memories are overwritten first, then the Presets; a Status window tracks the current progress. If Presets are locked, you are prompted to unlock them. If you click OK without unlocking them the Write All action is aborted; only the User Memories will have been transferred.

To copy settings from a Unit’s User Memory to a Preset Memory

1. Select a PC Memory Location between 33 and 64 which is unused or whose current settings are no longer required. This will force the unit offline.
2. Set the Unit online.
3. Recall the User memory from the unit, as described above.
4. Store the settings to the Unit using the Write All command, as described above.
8.2. Global Memory Management

Memories can be simultaneously recalled or stored to/from multiple units from the global Memory Management screen.

To open the global Memory Management screen
- Switch to the Fast Navigation screen and choose Memory Management.

The screen shown below is opened. It has two tabs (of similar appearance) as follows:

Read \ Write Memories - for globally downloading or uploading all user and preset memories between Add-ins and their respective slave units.

Store \ Recall Memory - for uploading or downloading a specific User Memory between Add-Ins and their respective slave units.

The synchronise direction is specified here for global uploads and downloads.

To Read/Write All Memories from/to multiple units

1. Switch to the Read \ Write Memories tab.
2. Tick the check box of each Unit for which memories should be downloaded/uploaded.

Hint
- If uploading/downloading to most units, use Select All to tick all units in the destination list, then clear check boxes as required. When starting a new selection, use Deselect All to quickly clear all previous ticks.

3. Set the Synchronisation to Get All Initial values from the Audio System or Set All Initial values from Computer, as required.
4. Ensure the Preset Memories are unlocked at the relevant Units.
5. Click Read All Memories or Write All Memories as required.
The HELIX RCS will work through the ticked units in the list, setting each online in turn. As the download/upload takes some time to complete, the current progress is tracked by the status indicators to the right of the list while more specific progress remarks are displayed in the Comments column, for example, success or failed to go online. **On completion, remember to relock the Preset Memories!**

To Store/Recall settings to/from a specific Memory number, across multiple units:

1. Switch to the Store\Recall Memory tab.

2. Select the User or Preset Memory to be stored/recalled from the drop down list to the right of the 'tick list.'

   **Note** Settings cannot be stored to Preset memories on an individual basis; if you select a Preset Memory location, the Store button is faded out. To store a Preset memory you must use the write all command - this downloads each PC memory only to the equivalently numbered Unit Memory, thus providing an extra safeguard against accidentally overwriting essential settings.

3. Tick the check box of each Unit that you wish to include in the store/recall.

4. Set the Synchronisation to Get All Initial values from the Audio System or Set All Initial values from Computer, as required.

5. Click Recall From Memory or Store To Memory as required.

The HELIX RCS will work through the ticked units in the list, setting each online in turn. Progress is tracked by the status indicators to the right of the list and more specific progress remarks are displayed in the Comments column.

To return to the Fast Navigation screen, click Exit.